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Start

Mints is a growing collection of tools to provide deeper insight into macOS, to help you understand how its features work, and to help
diagnose its problems. In this release, 24 tools are provided: these deliver log extracts covering iCloud, TCC privacy protection, Time
Machine backups, the App Store, disk mounting, triald, Visual Look Up and task scheduling, test Spotlight search, list boot times,
XProtect scans and Software Update information over the last 24 hours, look for Universal binaries, and show information about the
Mach timebase, hardware, process environment, sudo, logs, SSDs, mounted volumes, sysctl and keychains. There’s also a menu in
the Window menu to explore different data types, including resolving inode numbers to regular paths, Doubles and Unicode
normalization, a browser window for Visual Look Up, and a window to explore floating-point number formats.

Complex systems in macOS write dialogues to the log while they operate. Following these in a normal log extract can be difficult,
because lines in each conversation are interspersed with other irrelevant entries. Mints’ log browsers are different because they bring

together entries from many different sub-systems and services, helping you to follow those dialogues. The use of colour to distinguish
different sub-systems makes these conversations even more understandable.

o o Mints Time Machine log

period | -20/ s min [ relativeto 14/07/2020, 16:00:34 % Now
Time Machne @ DAS @ cTs @ Other

Get log Save

20-07-14 15:44:51.668 DuetAS @:com.apple.backupd-auto:@45ABB: [

{name: DeviceActivityPolicy, policyWeight: 2.00@, response: {Decision:
Can Proceed, Score: 0.40}}

{name: MemoryPressurePolicy, policyWeight: 5.000, response: {Decision:
Can Proceed, Score: .50, Rationale: [{[memoryPressurel: Required:2.08,
Observed:1.00}, 1}}

1 sumScores:31.810000, denominator:35.510000, FinalDecision: Can Proceed
FinalScore: 0.895804}

20-07-14 15:44:51.668 DuetAS '@:com.apple.backupd-auto:@45ABB"
CurrentScore: ©.895804, ThresholdScore: 8.758907 DecisionToRun:1
20-07-14 15:44:51.669 CTS-XPC DAS told us to run com.apple.ba

20 @ TimeMach  TMPowerState: 2
20-07-14 15:44:51.770 DuetAS STARTING activity @:com.apple.backupd—
auto:@45ABB <private>!

=» Contents =»> Main window
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=» Log Windows =» iCloud - TCC

=» Trial =» Time Machine =» App Store  =» Disk Mount
=> Look Up => DAS Scheduling =» Boot

Spotlight =» Log Window

=>» Create Test =>» Check Search =>» Delete Test

Information =» Mac =>» Disk Check =» Volume

=» Keychain =>» Environment => Mach Absolute Time

=» Logs =» XProtect Scans = Software Update

=>» Sysctl Info =>» Universal Binary Checker

Window menu

=» Visual Look Up

Data... sub-menu =» Inode =» Double =» Normalizer
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=» Updates =» Further information
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Main window

Log Windows

uuuuuuuuuuuuuuuu

Spotlight

yyyyyy

The main window currently offers 24 buttons to:
open the =» iCloud Log Window, to explore iCloud messages in the log,
open the =» TCC Log Window, to explore TCC and privacy system messages in the log,
+ open the =¥ Trial Log Window, to explore the new trial service in the log,
open the =» Time Machine Log Window, to explore Time Machine backup messages in the log,
+ open the =¥ App Store Log Window, to explore App Store messages in the log,
« open the =¥ Disk Mount Log Window, to explore APFS and related subsystems in the log,
« open the =¥ Visual Look Up Window, to explore Visual Look Up messages in the log,
+ open the =% DAS Scheduling_Log Window, to explore task scheduling messages in the log,
« open the =% Spotlight Log Window, the explore Spotlight searches in the log,
+ list the =» times of all boots over the last 24 hours,
« = create, run and delete a test of Spotlight search,
« =» Get Mac Info,
« = run a Disk Check,
+ =» Get Volume Info,
+ =» Get Keychain Info,
+ =>» Get Environment Info, about process execution environment,
+ open =» Mach Absolute Time, to get information about clock rate and conversion factors,
+ list =» Unified log information
« list =» XProtect Scans reported over the last 24 hours
+ list =» Software Update information over the last 24 hours
+ open =» Sysctl Info to get a wide range of information about that Mac and its system
« open the = Universal Binary Checker, to discover which apps and other code runs native on Apple Silicon Macs (Mojave and later only).
When you close this window, Mints will quit.

=» Log_window controls
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Log window controls

[ NON Mints Time Machine log
Period | -20|  min a relative to | 14/07/2020, 16:00:34 N Now
Time Machne @ DAS @ CTs @ Other
Get log Save

[<private>] resolving item: (null)
'ho Jocuments/

codepro]

options: 768

20-07-14 15:44:51.668 DuetAS @:com.apple.backupd-auto:045ABB: [

Each log window in Mints offers a simple method to specify the precise period over which log entries are to be
extracted. This is based on a reference time, entered in the relative to box using its standard controls, and a
Period offset from that reference, set using its stepper arrows or by editing the text directly. You can also copy and
paste times in the relative to box: simply select an item in the box and use the normal commands.

The offset entered in the Period box has a popup menu to determine its units. There is also a button Now which
will set the reference time to the immediate present. Use that with a period of —20 sec to get log entries over the
last 20 seconds.

To get a log extract for the 1 minute before a reference time, simply set Period to —1 and the popup menu to min.
To obtain an extract for 10 seconds each side of a time in the past, the total period wanted is 20 seconds. You can
either specify that using the reference time at the start of that period and 20 sec, or the time at the end of the
period and —20 sec.

=» Log window controls (concluded)
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Log window controls (concluded)

The shortest period which can be used here depends on the version of macOS. In Sierra, periods less than about
30 seconds are unreliable, and entries can be missed. In Mojave and Catalina, shorter periods can be used, even
below 10 seconds if you wish.

Times in the relative to box are in the current time zone for the set date. On days when clocks change, they use
the second of the two zones. For example, when the change to summer time occurs on a day, times entered here
for that day use summer time throughout.

The row of controls below the time settings set which sub-systems are shown in the log view in the main part of
the window. Each uses an emoji to indicate the colour in which those log entries are displayed.

The last controls are two buttons: Get log, which runs the log show command to fetch a fresh log extract, parse
and display it, and Save, which saves what’s currently displayed of the log in Rich Text format, which you can also
do through the Save command in the File menu.

To enlarge the size of the text in any log extract, press 3 +; to reduce the size, press ¥#—.

Each time you open Mints, it checks whether your log is in order and accessible. If it detects any problems, it will
warn you about them, and suggest fixes when possible.

=» iCloud log
=» Unified log information
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iCloud log

[ NON ) Mints iCloud log
Period S sec relative to  14/07/2020, 16:02:00  ° Now
CloudDocs @ CloudKit @ MMCS @ Other
Get log Save

StateComplete 1

20-07-14 16:01:44.680 [kernel]l com.apple.p2p: AWDL Active Time
1797ms (13%) 12.871s[2491065.044s — 2491077.916s]

20-07-14 16:01:44.688 [kernel]l 2491077.923922 wlan®.A[542657]
getOP_MODER67:not supported on this interface

20-07-14 16:01:44.703 [kernel]l 2491077.939659 wlan@.A[542658]
getOP_MODER67:not supported on this interface

20-07-14 16:01:44.712 [kernel]l 2491077.948537 wlan@.A[542659]
getOP_MODER67:not supported on this interface

20-07-14 16:01:45.911 [kernel]l 2491079.147504 wlan@.A[542660]
updatelLQME3331:No per core RSSI to report

20-07-14 16:01:46.060 CloudKit Checking TCC authorization for with 1
proxy.

20-07-14 16:01:46.060 CloudKit Checking TCC authorization for
bundleID:<private> with 1 proxy.

20-07-14 16:01:46.060 CloudKit TCC accepted a token for
bundleID:<private>, proxy:<private>

20-07-14 16:01:46.060 CloudKit Checking TCC authorization for
bundleID:<private> with 1 proxy.

20-07-14 16:01:46.060 CloudKit TCC accepted a token for
bundleID:<private>, proxy:<private>

20-07-14 16:01:47.279 [kernel]l TX(44:94:FC:20:67:6D) <Success NoACK
Expired OtherErr> BE<O © @ 0> BK<@ © © 0> VI<0 © © 0> V0O<0 0 0 o>
(5001ms)

20-07-14 16:01:47.279 [kernel] L3 Control VO TX(44:94:FC:20:67:6D)

The iCloud log extract shows entries from the three major sub-systems involved in iCloud transactions, and
various related services and the kernel in the Other category. These are the same as shown in my free iCloud
utility Cirrus.

=> TCC log
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TCC log

[ NON | Mints TCC & privacy log
Period S sec relative to 14/07/2020, 16:01:40 ¢ Now
TCC @ LaunchServs @ securityd @ Other
Get log Save

20-07-14 16:01:20.338 securityd could not enable test hierarchy: no UAT
pinning preferences set

20-07-14 16:01:20.616 kernel PMRD: setAggressiveness(0)
kPMMinutesToSleep = @
20-07-14 16:01:20.889 kernel 2491054.125156 wlan@.A[542641]

updatelLQM@3331:No per core RSSI to report

20-07-14 16:01:21.760 LaunchServ LSExceptions shared instance
invalidated for timeout.

20-07-14 16:01:21.882 LaunchServ LSExceptions shared instance
invalidated for timeout.

20-07-14 16:01:22.273 kernel TX(44:94:FC:20:67:6D) <Success NoACK
Expired OtherErr> BE<O © © 0> BK<O © © 0> VI<O © © 0> V0O<0 0 0 o>
(5000ms)

20-07-14 16:01:22.273 kernel L3 Control VO TX(44:94:FC:20:67:6D)
Success=0 NoACK=0 Expired=0 OtherErr=0

20-07-14 16:01:22.273 kernel TX(FF:FF:FF:FF:FF:FF) <Success NoACK

Expired OtherErr> BE<O @ 0 0> (5000ms)
20-07-14 16:01:25.659 LaunchServ LSExceptions shared instance
invalidated for timeout.

20-07-14 16:01:25.897 kernel 2491059.133576 wlan@.A[542642]
updateLQM@3331:No per core RSSI to report
20-07-14 16:01:26.439 kernel Sandbox: com.apple.Safari(932) deny(1)

file-read-data /Users/hoakley/Library/
Preferences/.GlobalPreferences.plist
20-07-14 16:01:26.442 kernel PMRD: setAggressiveness(9)

The TCC log extract shows entries from the three major sub-systems involved in controlling privacy and controlled

access in Mojave and later. The Other category here includes additional services and the kernel. These are the
same as shown in my free utility Taccy.

=» Trial log
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Trial log

[ ) [ ] Mints Trial log
Period -1 Z hour relative to 01/04/2022, 04:00{if§) 2 Now
trial @ triald @ CloudKit @ Other @
Get log Save

22-04-01 03:08:03.063 triald server : TRIXPCStatusRequestHandler
0x7fa8ee7@edc@: end activeEvaluationsForMLRuntimeWithCompletion:

22-04-01 03:08:03.063 triald server : Connection to com.apple.trial.status
from (null) (4781) was invalidated.

22-04-01 03:08:03.065 triald server : received xpc event
com.apple.triald.wake

22-04-01 03:08:03.065 trial _ : failed to read system info from file
<private>: Error Domain=NSCocoaErrorDomain Code=257
UserInfo={NSFilePath=<private>, NSUnderlyingError=0x7fe@8dflifef@ {Error
Domain=NSPOSIXErrorDomain Code=1}}

22-04-01 03:08:03.065 trial _ : failed to read system info from file
<private>: Error Domain=NSCocoaErrorDomain Code=257
UserInfo={NSFilePath=<private>, NSUnderlyingError=0x7fe08ebl3ec@ {Error
Domain=NSPOSIXErrorDomain Code=1}}

22-04-01 03:08:03.069 triald server : received xpc event
com.apple.triald.wake

22-04-01 03:08:03.069 trial _ : failed to read system info from file
<private>: Error Domain=NSCocoaErrorDomain Code=257
UserInfo={NSFilePath=<private>, NSUnderlyingError=0x7fe08e90a480 {Error
Domain=NSPOSIXErrorDomain Code=1}}

22-04-01 03:08:03.069 trial _ : failed to read system info from file
<private>: Error Domain=NSCocoaErrorDomain Code=257
UserInfo={NSFilePath=<private>, NSUnderlyingError=0x7fe@8e9054f0 {Error
Domain=NSPOSIXErrorDomain Code=1}}

22-04-01 03:08:19.028 mediaanld AppSandbox

22-04-01 03:08:19.040 mediaanld Membership API: translate identifier
22-04-01 03:08:19.041 mediaanld container_create_or_lookup_for_current_user
22-04-01 03:08:19.041 mediaanld container_create_or_lookup_for_platform
22-04-01 03:08:19.041 mediaanld xpc : Requesting container lookup; personaid =

The Trial log extract shows entries from the major sub-systems involved in the new trial service in macOS Big Sur
and Monterey. These include Signposts, and where given each entry starts with the category, in the form
[category] : [entry body].

=» Time Machine log
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Time Machine log

[ NON ) Mints Time Machine log
Period | -20/ ¢ min relative to  14/07/2020, 16:00:34 < Now
Time Machne @ DAS @ cTs @ Other
Get log Save
20-07-14 15:42:10.153 [other] [<private>] resolving item: (null)

[4212AAFD-3C28-4F5C-85F9-07D6E3FD397D] — URL:/Users/hoakley/Documents/
Xcodel@/T2M2/TheTimeMachineMechanic/TheTimeMachineMechanic.xcodeproj
options: 768
20-07-14 15:44:51.668 DuetAS 0:com.apple.backupd-auto:@45ABB: [

{name: DeviceActivityPolicy, policyWeight: 2.000, response: {Decision:
Can Proceed, Score: 0.40}}

{name: MemoryPressurePolicy, policyWeight: 5.000, response: {Decision:
Can Proceed, Score: 0.50, Rationale: [{[memoryPressurel]: Required:2.00,
Observed:1.00}, 1}}

] sumScores:31.810000, denominator:35.510000, FinalDecision: Can Proceed

FinalScore: 0.895804}

20-07-14 15:44:51.668 DuetAS '@:com.apple.backupd-auto:045ABB'
CurrentScore: 0.895804, ThresholdScore: 0.758907 DecisionToRun:1
20-07-14 15:44:51.669 CTS-XPC DAS told us to run com.apple.backupd-
auto

20-07-14 15:44:51.769 CTS-XPC com.apple.backupd-auto state change 1
-> 2

20-07-14 15:44:51.769 CTS-XPC Initiating XPC Activity:
com.apple.backupd-auto

20-07-14 15:44:51.770 CTS-XPC taking power assertion:

com.apple.backupd-auto: 38319

20-07-14 15:44:51.770 TimeMach TMPowerState: 2

20-07-14 15:44:51.770 DuetAS STARTING activity @:com.apple.backupd-
auto:045ABB <private>!

The Time Machine log extract shows entries from the three major sub-systems involved in scheduling,
despatching and making Time Machine backups. The Other category here shows related services, but doesn’t

include the kernel. Although based on the extracts analysed by my free utility The Time Machine Mechanic, these
extracts are new for Mints.

=» App Store log
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App Store log

@ @ Mints App Store log

Period -20 { min relative to 05/05/2021, 12:21:32 s Now
AppStore @ AMS @ appstored @ Other @

Get log Save
21—05—05 12:19:26.513 AppStore App Store bootstrap completed
21-05-05 12:19:26.515 AMS AMSAcknowledgePrivacyTask: [AC15E192] Determining if privacy acknow!
21-05-05 12:19:26.519 AMS AMSAcknowledgePrivacyTask: [AC15E192] Privacy acknowledgement is no
21-05-05 12:19:26.520 AMS AMSAcknowledgePrivacyTask: [AC15E192] Determining if privacy acknow!
21-05-05 12:19:26.523 AMS AMSAcknowledgePrivacyTask: [AC15E192] Privacy acknowledgement is no
21-05-05 12:19:26.523 AppStore Onboarding finished.
21-05-05 12:19:26.524 AMS AMSAcknowledgePrivacyTask: [AC15E192] Determining if privacy acknow!
21-05-05 12:19:26.525 AMS AMSAcknowledgePrivacyTask: [AC15E192] Privacy acknowledgement is no
21-05-05 12:19:26.526 AMS AMSAcknowledgePrivacyTask: [AC15E192] Determining if privacy acknow!
21-05-05 12:19:26.526 AMS AMSAcknowledgePrivacyTask: [AC15E192] Privacy acknowledgement is no

21-05-05 12:19:26.561 appstored [AppStoreKit.UpdateStore]: getUpdatesWithCompletionBlock

21-05-05 12:19:26.561 appstored [C56AD324] getUpdates requested for client: com.apple.AppStore
21-05-05 12:19:26.563 appstored [C56AD324] Returning @ available and 14 recent update(s)

21-05-05 12:19:26.563 appstored [C56AD324] getUpdates completed sucessfully

21-05-05 12:19:26.565 appstored [AppStoreKit.UpdateStore]l: refreshUpdateCountWithCompletionBlock
21-05-05 12:19:26.565 appstored [4DA2F90QE] refreshUpdateCount requested for client: com.apple.AppStc
21-05-05 12:19:26.566 appstored [4DA2F90QE] Current update count: © elapsedTime: 0.000146

21-05-05 12:19:26.566 appstored Leaving badge count at: @ badgeValue: © reason: Client Refresh Couni
21-05-05 12:19:26.566 appstored [4DA2F90QE] Refresh update count returning count: @

21-05-05 12:19:26.566 appstored [4DA2F90E] refreshUpdateCount completed sucessfully

21-05-05 12:19:26.580 appstored [1C178923] Completed with 179 result(s)

21-05-05 12:19:26.600 kernel Sandbox: 1 duplicate report for App Store deny(1) mach-lookup com.a
21-05-05 12:19:26.600 kernel Sandbox: App Store(24415) deny(1) mach-lookup com.apple.remoted
21-05-05 12:19:26.603 kernel PMRD: setAggressiveness(@) kPMMinutesToSleep = @

21-05-05 12:19:26.624 kernel Sandbox: App Store(24415) deny(1) mach-lookup com.apple.AddressBook
21-05-05 12:19:26.630 kernel Sandbox: App Store(24415) deny(1) file-read-data /private/var/folde
21-05-05 12:19:26.631 AMS AMSURLSession: [3BDA5CF9] Task received response

The App Store log extract shows entries from the three major sub-systems involved in obtaining, downloading,
installing and updating App Store apps. AMS is Apple Media Services, and the Other category here shows the
kernel and other related services.

=» Disk Mount log
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Disk Mount log

o [ ] Mints Disk Mount log
period 30 I sec @) relativeto 25/03/2023, 16:16{ Now
APFS + @ MAU @ DiskMan @ DiskArb @
Get log Save

23-03-25 16:16:46.257 MAU <private>
2 DiskArb diskmanagementd [543]:61443 —>

DiskArb

23-03-25 16:16:46.457 DiskMan _DMAPFSDataVolumeForGroupedVolume
IntErr=1=0x1 recommend=1 retarget from uncontrolledif-DATA-
v0l=0x16f5be640=disk3sl+(snap=1) to isassured-DATA-
vol=0x16f5be510=disk3s5

23-03-25 16:16:46.464 apfs tx_flush:1241: disk3 xid 1308693 tx
stats: # 140 finish 138 enter 389 wait 5 370Qus close 4us flush 1189us
23-03-25 16:16:46.466 DiskMan _DMisAppleTargetDiskModeLockedDisk

The Disk Mount log extract shows entries from processes involved in mounting APFS disks. APFS + shows
entries from I0AccessoryManager (I0OAccMan) and APFS, which bear the brunt of the work. Because they’re
seldom active at the same time, both processes are shown in the same category. MAU is
MobileAccessoryUpdater, whose messages are normally given as <private> unless you remove privacy from
the log. DiskMan is DiskManagement, and DiskArb is DiskArbitration and diskarbitrationd, which contain
some important milestones.

This log extract is also valuable for studying APFS entries in the log more generally. As they usually come direct
from the apfs process, they won’t normally be found using a subsystem in a predicate.

=» Visual Look Up log
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[ ] [ ] Mints Look Up log
Period 8 £ sec @ relativeto 20/03/2022, 22:06{13 < Now
VisionKit @ Espresso @ PegasusKit @ Other @
Get log Save

22-03-20 22:06:45.256 VisionKit
22-03-20 22:06:45.256 VisionKit

signposts :
com.apple.VisionKit : BEGIN

lyzerPr tEven

"VKImag

22-03-20 22:06:45.256 VisionKit
Request: 34 — <private>
22-03-20 22:06:45.256 VisionKit
22-03-20 22:06:45.256 VisionKit

1t
com.apple.VisionKit.processing : Processing

signposts :

com.apple.VisionKit : BEGIN "VisionKit MAD

=» Contents

Parse Request"
22-03-20 22:06:45.256 VisionKit com.apple.VisionKit.processing : Added request
to Mad Interface with total method return time: 0.000019 request: <private>
22-03-20 22:06:45.267 VisionKit  com.apple.VisionKit.processing : Request
Submitted to MAD: <private>
22-03-20 22:06:45.267 VisionKit  com.apple.VisionKit.processing : Assigned
madId: 2 to vkId:
2:0

34

ceived on-demand image

Mon Mar 21

imits until

DServicePublic] MADRequestID 2 sche

ate>
VCPMADVIVisualSearchGatingTask running...
Destroying plan 140608060832256

Espresso

espresso :

22-03-20 22:06:45.269 Espresso espresso : Destroying context 140608046085296
22-03-20 22:06:45.270 Espresso espresso : Destroying plan 140608061252608
22-03-20 22:06:45.271 Espresso espresso : Destroying context 140608047936080
22-03-20 22:06:45.272 Espresso espresso : Destroying plan 140608060854272
22-03-20 22:06:45.278 Espresso espresso : Destrovina context 140608048133648

The Visual Look Up log extract shows entries from the major sub-systems involved in performing Visual Look Up
for images in macOS Monterey. These include Signposts, and where given each entry starts with the category, in
the form [category] : [entry body].

To save you from having to open another app to perform Visual Look Up, use that command in the Window menu
to open a browser window within Mints.

=» Visual Look Up window
=> DAS Scheduling_log
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DAS Scheduling log

[ JOX | Mints DAS-CTS Scheduling log
Period -5/ min u relative to  11/10/2020, 10:18:05 s Now
DAS @ CcTs @ XPC Remote @ Kernel @
Get log Save

20-10-11 10:14:10.679 XPC-remote [Ox7fa?11§eébf9] Message 2219
recevied , dispatching handler block
20-10-11 10:14:10.679 XPC-remote localbridge> Heartbeat 71564 succeeded

20-10-11 10:14:10.886 kernel 1431315.825506 wlan@.A[296957]
updateLQM@3339:No per core RSSI to report

20-10-11 10:14:11.556 CTS-XPC Creating XPC Activity:
com.apple.mds.Health check (2).0

20-10-11 10:14:11.556 CTS-XPC Submitting DASActivity: <_DASActivity:

"Q:com.apple.mds.Health check (2).0:FBD201", Utility, 60s, [10/11/20
10:14:11 AM - 10/18/20, 10:14:11 AM], Group: "com.apple.dasd.default",
Plugin Required, Delayed Start, User Specified: { }>

20-10-11 10:14:11.556 DuetAS SUBMITTING: <private>

20-10-11 10:14:11.556 CTS-XPC Registered XPC Activity:
com.apple.mds.Health check (2).0

20-10-11 10:14:11.556 CTS-XPC com.apple.mds.Health check (2).0:
<dictionary: 0x7fa90f629160> { count = 8, transaction: @, voucher = 0x0,
contents =

"_SequenceNumber" => <uinté4: ©0x223cb64c7b68bc51>: 1

"GracePeriod" => <inté64: 0x223ché4ce8c@ac4l>: 604800

"PowerNap" => <bool: @x7fff974464b0>: false

"DuetAttributeName" => <string: @x7fa90fé61cl1de> { length = 16,
contents = "Health check (2)" }

"Delay" => <inté4: 0x223cbé4c7bbé8acsl>: ©

"AllowBattery" => <bool: Ox7fff974464b0>: false

"DuetAttributeValue" => <string: @x7fa90f6130c@> { length = 1,

The DAS scheduling log extract shows entries from the two major sub-systems involved in macOS background
scheduling, which despatch and execute tasks, DAS (Duet Activity Scheduler) and CTS (XPC, Centralized Task

Scheduling). The XPC Remote category here shows entries for XPC External, and Kernel shows messages from
the kernel.

Routine background tasks in macOS often use this system for their scheduling. DAS determines when they can be
run, according to priorities and load, then calls on CTS to call them using XPC. This log extract lets you watch the
dialog between DAS and CTS, supplemented by information about external XPC activity, and that of the kernel.
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Boot times

@ O Mints Boot Time Scan

Startup times in the last 24 hours:
2021-05-23 15:05:38.066711+0000 1501F629-4A5C-4BA0—-ABFD-0OF3877575E6F
2021-05-23 15:36:29.635620+0000 90951415-97A9—-4EED-8A23-6689440DE4FB

When you open the Boot window, Mints searches the last 24 hours of your Mac’s unified log to identify each
occasion on which it started up. This takes some time - typically at least a couple of minutes - during which a
progress indicator spins. Once it has found all those times, it displays them in this window, giving the log time at
which that boot started (note carefully the time zone correction provided), and the UUID for that boot. You can then
use those in log browsers like Ulbow to discover the cause of any preceding kernel panic, etc.

=» Unified log information
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O [ ] Mints Spotlight log
Period -40 { sec relative to 07/02/2021, 07:08:45 < Now
Server @ Index @ DiskArb @ mdworker/stores @
Get log Save
21-02-07 ©7:08:17.907 DiskArb set client port, id = mdworker_shared [52564]:221451.
21-02-07 ©7:08:17.907 DiskArb
21-02-07 ©7:08:17.907 DiskArb mdworker_shared [52567]:419867 -> diskarbitrationd [95]
21-02-07 ©7:08:17.907 DiskArb set client port, id = mdworker_shared [52567]:419867.

21-02-07 ©7:08:17.907 mdworker Membership API: translate identifier
21-02-07 07:08:17.907 mdworker Membership API: translate identifier
21-02-07 07:08:17.907 mdworker Membership API: translate identifier
21-02-07 ©7:08:17.907 mdworker Membership API: translate identifier
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.932 mdworker Loading Preferences From System CFPrefsD
21-02-07 ©7:08:17.952 mds_stores compressing 5686 bytes to <private>
21-02-07 ©7:08:17.954 mds_stores compressing 5740 bytes to <private>

21-02-07 07:08:22.863 Server KEEP!!!!1 Client <private>[52556 52556] xpc checking in

21-02-07 07:08:22.882 Server directQueryOpenReply -1827749887 1795162144 © 0x21

21-02-07 07:08:22.882 Server QueryOpen succeeded (@) for store <private> 0x21

21-02-07 07:08:23.024 Index sort 130923 flat pages: 0.001706 seconds

21-02-07 07:08:23.123 Index sort 381016 flat pages: 0.004475 seconds

21-02-07 07:08:23.207 Server directQueryFetchResultsReply -1827749887 1795162144 35 at gos 0x21
21-02-07 07:08:24.612 Index sort 7039351 flat pages: 0.100238 seconds

21-02-07 07:08:25.355 Server directQueryFetchResultsReply -1827749887 1795162144 35 at qos 0x15
21-02-07 07:08:25.355 Server directQueryFetchResultsReply -1827749887 1795162144 @ at gos 0x15

The Spotlight log extract shows entries from the three sub-systems involved in maintaining and accessing the
Spotlight indexes: Spotlight Server, Index, and Disk Arbitration. The mdworkers/stores category here shows
entries for mdworker_shared and mds_stores.

=» Spotlight check and test
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Spotlight check and test

o €] Spotlight Query Test

Spotlight query returned 13 results:
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestB.pdf
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestC.txt
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestE.docx
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestD.html
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestMD. txt
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestEXIF.jpg
/Users/hoakley/Library/Group Containers/493CVA9A35.com.red-sweater/Library/Application Support/
MarsEdit4/Backups/The Eclectic Light Company-Spotlight on search_ Better and different, 3rd party
apps.78EAA2B1-3AB1-4E21-A358-723AE8D41E6A. txt
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestD.html
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestB.pdf
/Users/hoakley/Library/Mobile Documents/ pple~CloudDs backupl/SpotTests/SpotTestE.docx
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestC.txt
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestEXIF.jpg
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestMD.txt

Three buttons let you perform tests on Spotlight indexing and search, which are conveniently linked with inspecting its entries in the
log.

Create Test creates a new folder in your Home folder named MintsSpotlightTest4syzFiles to contain the test files. Mints then copies 9
files there for testing purposes. To delete that folder and its contents, use the Delete Test button.

Check Search performs a Spotlight search for the text syzygy999 in files in the whole of your Home folder, including iCloud. It then
opens a new window and displays the results, which should include the test files SpotTestA.rtf (Rich Text), SpotTestB.pdf (PDF),
SpotTestC.ixt (plain text), SpotTestD.html (HTML), SpotTestE.docx (Microsoft Word), SpotTestF.numbers (Numbers),
SpotTestG.pages (Pages), SpotTestEXIF.jpg (EXIF metadata in JPEG), and SpotTestMD.txt (Keywords extended attribute). You can
also add your own containing the search text to the folder. In addition to reporting which files were found, Mints also reports UTI and
Spotlight Importer information for each test file in that folder, and gives the time taken to perform the search.

A standard check might start with Create Test at a clock time of, say, 01:00:00, followed by Check Search at 01:00:10. At 01:00:30
open the Spotlight log and set the period to -30 seconds to capture all entries since 01:00:00. When finished, clean up using Delete
Test to delete the test folder and its entire contents, including any custom files you may have put there.

=» Spotlight log
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Get Mac Info

[ JOX ) Mints Mac Info

Mac model = iMacProl,1
Machine name = iMac Pro
Version = 1.0
Serial number = CO2VX2LXHX87
Hardware UUID = 4BB99205-CB23-5758-88EQ-E59A16FF4605
CPU = Intel(R) Xeon(R) W-2140B CPU @ 3.20GHz, 8 cores
Logic board ID = Mac-7BA5B2D9E42DDD94
Physical memory = 32 GB
Total physical memory = 34.36 GB
PCI Devices =
ethernet, Apple AQC107-AFW
Accelerators =
AMDRadeonX5000_AMDVegal@GraphicsAccelerator
AHCI Disks =
Samsung SSD 860 EVO 2TB, rev RVT@3B6Q, serial S4XINE@MCOO366L
Samsung SSD 860 EVO 2TB, rev RVTO3B6Q, serial S4X1INEOMAG2890F
Samsung SSD 860 EVO 2TB, rev RVT@3B6Q, serial S4X1INE@M702005R
Samsung SSD 860 EVO 2TB, rev RVT@3B6Q, serial S4X1INE@MCOO358X
Metal graphics devices =
AMD Radeon Pro Vega 56
Firmware version = 1037.147.4.0.0 (iBridge: 17.16.16610.0.0,0)
Darwin Kernel Version 19.6.0: Thu Oct 29 22:56:45 PDT 2020; root:xnu-6153.141.2.2~1/RELEASE_X86_64
Running macOS Version 10.15.7 (Build 19H15)
Last booted { sec = 1604608205, usec = 267786 } Thu Nov 5 20:30:05 2020

This window lists information about your Mac’s hardware. This includes:

+ the model designator, e.g. iMac17,1, machine name and version

+ the serial number of that specific Mac, its hardware UUID

+ the CPU type and details, and the ID for its logic board

+ physical memory installed (two units), PCI devices (Ethernet card)

+ graphics accelerators, AHCI disks, Metal graphics devices

+ firmware version, kernel version, macOS version, and time of last boot.
Further items will be added to this list in the future.

Increase the size of the text used with 3+; to reduce the size, press 3#— . Save the text to a text file using the Save...
command in the File menu.
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Run a Disk Check

@ o Mints Disk Check

Check Disk  /Volumes/OWCenvoyPro4tb

Parent disk device: disk5

Bus protocol: PCI-Express

Disk name: OWCenvoyPro4tb

Mount point: /Volumes/OWCenvoyPro4tb
Disk size: 3840546226176 bytes

SMART indicators:
Data written: 0 3406159360000 bytes
Media errors: 0
Percentage used: 0%
Write/Size ratio: 0.89
Temperature: 29.8°C

To run a check on any mounted SSD, click the Check Disk button and select the disk you want to check. Mints then calls
diskutil for the information it can provide about that disk or container. The size given is normally for the whole disk, but
may sometimes be the selected container size.

SSDs using Apple Fabric or PCI-Express (PCle) buses over internal connections or Thunderbolt will normally provide
SMART indicators, but those aren’t available over USB, or through SATA interfaces. Those shown are:

- Data written gives the two standard byte counts, but only one is used to calculate the Write/Size ratio;

+ Media errors are given as -1 when no value is returned;

+ Percentage used is that of the manufacturer’s expected life for the SSD; -1 is given when no value is returned;

+  Write/Size ratio is the data written divided by the disk size; this rises with age, and typically should be able to exceed
600 before there’s any danger of the SSD failing through an excess of erase cycles, and in some cases that may be
significantly higher.

+  Temperature given may not be reliable, as many need correction according to manufacturers’ data.

For more reliable and extensive information, use a commercial product such as DriveDx.
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Get Volume Info

 JOX ) Mints Volume Info

Volume <ThunderBayil>:
format APFS (NOT case sensitive)
free space on </Volumes/ThunderBayl> is 593.92 GB of total 2 TB
used space 1.41 TB
available for important usage 653.27 GB
available for opportunistic usage 651.99 GB
sparse file storage available
file cloning available
volume supports compression.

Volume <ThunderBay2HFS>:
format Mac 0S Extended (Journaled) (NOT case sensitive)
free space on </Volumes/ThunderBay2HFS> is 1.77 TB of total 2 TB
used space 232.93 GB
available for important usage 1.77 TB
available for opportunistic usage 1.77 TB
sparse file storage NOT available
file cloning NOT available
volume supports compression.

This window lists capacity information for all volumes currently mounted in the path /Volumes. This includes:

+ volume name, format and case sensitivity

+ total free space and total capacity

+ the derived used space

+ the amount of space available for ‘important’ and ‘opportunistic’ use

+ whether sparse files, file cloning, and compression are supported.
On APFS volumes, this should include mounted snapshots, but doesn’t include the current Data volume in the startup
Volume Group (as that isn’t mounted in /Volumes).

Increase the size of the text used with 3 +; to reduce the size, press 3&— . Save the text to a text file using the Save...
command in the File menu.
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Get Keychain Info

[ BON J Mints Keychain Info
Check

Default (login) /Users/hoakley/Library/Keychains/login.keychain-db
keychain

unlocked readable writeable

Lock

Mac UUID: 4BB99205-CB23-5758-88E0-E59A16FF4605

Keychain Services version: 33718272

‘% Found default keychain.

The default keychain is now unlocked, readable, writeable.

Default keychain path: /Users/hoakley/Library/Keychains/login.keychain-db
&~ Current keychain search path:
/Users/hoakley/Library/Keychains/login.keychain-db
/Users/hoakley/Library/Application Support/Adobe/AIR/ELS/
com.adobe.formscentral.FormsCentralForAcrobat/PrivateEncryptedDatak
/Users/hoakley/Library/Keychains/loginMPro.keychain-db
[private/var/folders/t9/dsdtkd0161b3w6fcjhlyqvjm0000gn/T/accountsKeychainExportBC5/
accountsKeychainExport.keychain

/Library/Keychains/System.keychain
/Users/hoakley/Library/Keychains/login.keychain-db
/Users/hoakley/Library/Application Support/Adobe/AIR/ELS/
com.adobe.formscentral.FormsCentralForAcrobat/PrivateEncryptedDatak

This window has three simple button controls:
+ Check, which runs its checks and updates the information in its text boxes;
+ Unlock, which unlocks your default (login) keychain;
+ Lock, which locks your default (login) keychain.

When you click on the Check button, Mints runs its full battery of tests, and completes the text boxes as shown below.

Displayed in the Default (login) keychain box is the full path to the keychain which macOS is using as your main user
keychain at present. Even if you are using iCloud Keychain, this should be a path to the file named login.keychain-db in the
Library/Keychains folder of your Home folder. If it isn’t, then you need to establish why.

=» Get Keychain Info (concluded)
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Below that box are three smaller boxes, which tell you whether that default keychain is locked, readable, and writeable.
You can change two of those by clicking on the Unlock or Lock buttons nearby. When you click on Unlock, a dialog will
appear requiring you to enter the password for your default keychain (which should be the same as your normal user login
password) in order to unlock that keychain, although in Catalina that may only appear when you click on Lock.

Mints wants to use the “login” keychain.

Please enter the keychain password.

O
E OQ Password:|

? Cancel QIS

The bottom scrolling box contains the hardware UUID number of your Mac, its version number of Keychain Services, all the
information from the other boxes, and a lot more too.

You can save that to a text file using the Save... command in the File menu. You can also select, copy and paste any of
the text, but cannot modify it within this app.

You can resize text in the lower scrolling window between 4 and 24 points using 3+ to enlarge and 3— to reduce the size.

=» Keychain Details
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Keychain Details

Mac UUID: this should correspond with the Hardware UUID given in System Information.
Keychain Services version: this should be 33718272 for all versions of macOS from 10.12 to 10.15.

Default keychain path: should be /Users/[username]/Library/Keychains/login.keychain-db where [username] is the short user name
of the current user.

Current keychain search path: should include the default keychain and /Library/Keychains/System.keychain.

Keychain system search path: should include /Library/Keychains/System.keychain.

Keychain common search path: should include /Library/Keychains/System.keychain.

Keychain dynamic search path: most probably empty.

Keychain user search path: should include the default keychain.

Contents of ~/Library/Keychains: should include login.keychain-db, and is likely to include metadata.keychain-db too. For each file
found, the date and time of last modification is given first, then that of the file’s creation, then the size in bytes. The default keychain
should not be empty.

Contents of ~/Library/Keychains/[UUID]: this is the folder used for iCloud Keychain, or for the Local ltems listed in Keychain
Access. It may not exist, but if it does it should include keychain-2.db at least, and sometimes much more.

Contents of /Library/Keychains: should include System.keychain, and may well also include the Apple Push Services keychain
apsd.keychain

Contents of /System/Library/Keychains: should include SystemRootCertificates.keychain and is likely to contain EVRoots.plist,
X509Anchors, and SystemTrustSettings.plist.
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Get Environment Info

@ @ Mints Mac Environment

The environment is

["SSH_AUTH_SOCK": "/private/tmp/
com.apple.launchd.fJKbanU5np/Listeners", "SHELL": "/bin/
zsh", "COMMAND_MODE": "unix2003", "USER": "hoakley",
"__CF_USER_TEXT_ENCODING": "@x1F5:0x0:0x2", "PATH": "/
usr/bin:/bin:/usr/sbin:/sbin", "HOME": "/Users/hoakley"
"__CFBundleIdentifier": "co.eclecticlight.Mints",
"TMPDIR": "/var/folders/sz/
qb23fyss56v96vmh6@p8Tt7reeeegn/T/", "XPC_FLAGS": "ox@",
"LOGNAME": "hoakley", "XPC_SERVICE_NAME":
"application.co.eclecticlight.Mints.3126273.3126278"]
en_GB (current)

Controller:

Controller Information:
Model Name: Apple T2 Security Chip

Firmware Version: 18P4346
Boot UUID: 32379261-FA9A-4048-8CE3-088D26DE9A58

This window shows the process execution environment which processes launched by Mints would inherit. This is
of particular interest to anyone experiencing problems which may be attributable to environment variables.
Although the environment shown is that for Mints, it should be typical of most apps run. Of particular interest are
the shell, text encoding and any localisation, and TMPDIR variables.

Following that, an assessment is made as to whether the current version of macOS has been patched to fix the
serious vulnerability in the sudo command. This is omitted for more recent versions of macOS.

The Controller information given at the end is specific to the type of Mac, differing between non-T2 and T2 Intel
systems, and M1 Macs.
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Mach Absolute Time

@® ® Mints Mach Timebase Info

Running as Intel code:
Timebase numerator = 1
denominator = 1

factor = 1.0

Mach Absolute Time (raw) = 2812811885701462
Mach Absolute Time (corr) = 2812811885701462

This window displays conversion factors and other information about Mach Absolute Time, which differ between
Intel and Apple Silicon hardware, and between Intel code running using Rosetta 2 and native ARM code on Apple
Silicon systems.

This first line states which architecture the code was run on, then gives the two integers for the Mach timebase
correction, and the correction factor; multiply raw time values by that to scale them from ticks to nanoseconds.
Finally, it gives the current raw time, and that time after correction.

To discover the factors applied to Intel apps running in Rosetta 2 translation on an Apple Silicon Mac, force Mints
to Open using Rosetta on that Mac.
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Unified log information

[ ) Mints Unified Log Info

Unified log information:

Check of log files at /var/db/diagnostics:
11 items in the path /var/db/diagnostics;
51 files in the Persist folder;
337 files in the Special folder;
100 files in the Signpost folder;
9 files in the timesync folder.
There are 257 folders in the /var/db/uuidtext folder.

The oldest log entry has a datestamp of 2022-12-19T17_27_22Z, 1.712 days ago.

This window displays key information about the Unified log, including the contents and structure of the folders
used to store the log. The main log contents are at /var/db/diagnostics, with UUID content in /var/db/uuidtext.

Within the main folder:

+ Persist contains the main log files in tracev3 format, typically maintained to around 525 MB in more than 50
files;

- Special contains additional log files in tracev3 format. These are progressively weeded over time until they’r
eventually remove;

« Signpost contains signpost entries only;

- timesync contains time synchronisation data essential for datestamping of log entries;

- HighVolume is generally not used.

The datestamp of the first log entry in the oldest log file in the Persist folder is given, with the period currently
covered by log entries from that time.
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XProtect Scans (Catalina and later)

O o Mints XProtect Remediator Scan

XProtect Remediator scans completed in the last 24 hours:
2022-08-30 17:01:56.065898+0100 XProtectRemediatorDubRobber
{"caused_by":

[1,"status_message":"NoThreatDetected", "status_code":20, "execut
ion_duration":32.687495946884155}

2022-08-30 23:33:07.491289+0100 XProtectRemediatorDubRobber
{"caused_by":

[1,"status_message":"NoThreatDetected", "status_code":20, "execut
ion_duration":20.798694014549255}

2022-08-30 23:33:53.050802+0100 XProtectRemediatorDubRobber
{"caused_by":

[1,"status_message":"NoThreatDetected", "status_code":20, "execut
ion_duration":31.759665012359619}

2022-08-31 02:45:43.628198+0100 XProtectRemediatorDubRobber
{"caused_by":

[],"status_message":"NoThreatDetected", "status_code":20, "execut
ion_duration":16.603500008583069}

20272-0R8-21 A2+12+0R L7R4L772+0100 XPrantertRemediatnrNithRnhher

This window lists all reports recorded in the Unified log over the last 24 hours from the new anti-malware scanners
built into XProtect Remediator in macOS Catalina and later. Not all scans result in reports, but those that do
should appear in this list. Each entry reports the date and time of the report, the scanning module involved, then

the report exactly as it appears in the log. This may give a reason for that scan, then gives the result, and the time
taken in seconds.

Further information about this new security feature is available on the Eclectic Light Company blog.
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Software Update

[ ] [ ] Mints Software Update Scan

Software Update information in the last 24 hours
ZBZZ 08-19 22:59:25.638170+0100 [SUCoreDevice] Initialized new device:
[>>
targetedSystemVolume: /
dev. CES upportsMobile Gest lt YES
ice:

esul
eSupportsSFRSyst
s uppor tsSFRResto v n: NO
d eSupportsMulti! v Lum B t YES
bulldVerslo 21683

ion:
h M d ISt J137AP
device Cl ss Mac
productType: iMacProl,1
releaseType: (null)
deviceBoardID: Mac-7BA5B2D9E42DDD94
hwTarget: J137AP
isInternal: NO
isBDotedOSSECureInternal: NO
21.7.83.0.0,0
hasE beddedOS NO
hasBridge0S: YES
idgEBuildVErsl on: 19P6866
bridgeRestoreVersion: 19.16.16066.9.0,0

This window displays the results of looking up details of firmware, T2 BridgeOS, Secure Firmware Restore (DFU mode),
and fallback Recovery currently installed. This is obtained from a log entry made by one of the subsystems of Software
Update. It works in Monterey and Ventura, most probably in Big Sur, and possibly older versions of macOS, and with Intel
Macs with or without T2 chips, Apple silicon Macs, and macOS running in a virtual machine.

Note that the Recovery System referred to here isn’t the paired Recovery volume which is part of the boot volume group in
Monterey and later on Apple silicon Mac, and on all Intel Macs. On Apple silicon Macs running Big Sur, this is the primary
Recovery, as in macOS 11 they don’t have a paired Recovery volume. On Apple silicon Macs running Monterey and later,
with is the fallback Recovery system installed on a hidden container on the internal SSD, and engaged by a double-press-
and-hold of the Power button, instead of the normal Recovery system engaged by simply pressing and holding the Power
button. Paired Recovery should match the main macOS version.

This is particularly useful when run after a macOS update, when it can show versions before and after the update has been
installed.
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Sysctl Info

@ [ ) Mints sysctl Viewer

hw ()

hw.ncpu: 16

hw.byteorder: 1234
hw.memsize: 34359738368
hw.activecpu: 16
hw.features.allows_security_research: 0
hw.optional.floatingpoint: 1
hw.optional.mmx: 1
hw.optional.sse: 1
hw.optional.sse2: 1
hw.optional.sse3: 1
hw.optional.supplementalsse3: 1
hw.optional.sse4_1: 1
hw.optional.sse4_2: 1
hw.optional.x86_64: 1
hw.optional.aes: 1
hw.optional.avx1l_0: 1
hw.optional.rdrand: 1
hw.optional.fléc: 1
hw.optional.enfstrg: 1
hw.optional.fma: 1
hw.optional.avx2_0: 1

This window displays the output from the command tool sysct1, arranged by topic. This lists around a thousand different
settings in the hardware and software of each Mac. These are named using a dot-based system, and to make it easier to
locate those you’re most interested in, there’s a popup menu that selects which top-level category is displayed in the view
below.

Detailed accounts of many of the entries are given in Apple’s developer documentation, and in a page on the Eclectic Light

blog. To make this accessible, there’s a command in the Help menu sysctl Information that will open the page in your
default browser.
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Universal binary checker (Mojave and later)

[ ] @ /Users/hoakley/Documents/Oarchtests

Folder Flush
Scan Check all bundles Check Mach-O Save

Listing of all bundles which have ARM64 code in the folder /Users/hoakley/
Documents/Oarchtests:

Oarc
/Users/t Oarcl AacOS/ArchiChect
/Users/hoakley/Documents/Oarchtests/Ci

chte: il

[Users/t ts/Ci

0S/Cirrus

0S/Podofyllin

night

U
/Users/hoakley/Documents/Oarchtests/diskutil

Found 10 items which have ARM64 code, out of 7082 scanned in /Users/hoakley/
Documents/Oarchtests (including Mach-O files)
Checked at Monday, 20 July 2020 at 16:59:20 British Summer Time

Before scanning for Universal software, decide whether you just want apps scanned, or whether you want all code-containing
bundles scanned. To scan apps only, leave the checkbox labelled Check all bundles unchecked; to scan all bundles, ensure it is
ticked (the default).

Next, decide whether you want all executable (Mach-O) code files scanned too. These include dynamic libraries (dylibs), command
tools, and other code which is not delivered in a bundle. To scan all executable code, ensure that the checkbox labelled Check
Mach-O is ticked (the default); for a basic scan, leave that checkbox unchecked. Scanning all bundles and all Mach-O files will take
significantly longer.

Then decide which folder you wish to scan. You can select that in either of two ways:

+ leave the Folder text box empty, and click on the Scan button. You will then be prompted to select the folder using the normal
Open File dialog;

+ enter a standard path into the Folder text box. You can use the standard shortcut of ~ to indicate your Home folder. Once you
have entered the path, click on the Scan button to start the scan. If the Flush checkbox is ticked when you do this, the path in
the Folder text box will be cleared when the scan starts; if you uncheck the Flush checkbox, your path will be left for you to
edit it for the next scan.

=>» Universal binary checker (concluded)
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Scanning takes time. If you put the root path / in the Folder text box, this can take many minutes, even an hour or
so. You may wish to scan top-level folders like /Applications one at a time rather than attempting to scan your
entire Mac. During this period, the window shows a busy ‘spinner’ next to the Scan button, and you can work
normally with other apps. Give the app time to complete its scan, and once complete it will display the results.

Scanning takes plenty of memory. Because of the deep traversal which it uses, Mints consumes memory by the
GB in order to check every nook and cranny in the folder it is scanning. This should work fine with virtual memory,
though. Again, you can reduce this by performing scans on smaller folders.

When a scan is complete, the title of the window will change to show the folder which has just been scanned.
Change the size of the text in the output using 3+ to make it larger, to a maximum of 60 points, or 3— to make it
smaller, to a minimum of 4 points.

To save the results of a scan as a text file, click on the Save button, or use the Save... command in the File menu.
You will then be prompted to select the name of the text file.

The scanner performs a deep traversal of the chosen folder, using Bundle.executableArchitectures to list
executable architectures for each bundle. To check for Mach-O code files, it first inspects the ‘magic’ initial four
bytes of every file. If it finds that they are 0xfeedface, it then directly inspects the subsequent Fat Architecture
slices to check whether the supported architectures include ARM64.
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Window menu: Visual Look Up window

To test or investigate Visual Look Up, in addition to the log window provided by Mints, you’ll need to perform Visual
Look Ups. This is made easy by opening this browser window within this app. It automatically opens a special test
page on the Eclectic Light Company blog, containing various images for you to use in your tests. This is a normal
browser window, so can be used to navigate anywhere else, although it doesn’t support bookmarks, manual entry
of URLSs, or other conveniences.
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Data... menu: Inode

@ o iNode Resolver

iNode number 1239842
File /vol/16777242/68446
Resolve

file: "/Volumes/External1/Documents/OnewDownloads/brief-PFPL293612.pdf"
type: "\0\0\0\0"

creator: "\0\0\0\0"

attributes: avbstclinmedz

created: 09/11/2023 16:37:36

modified: 09/11/2023 16:37:36

This resolves inode numbers given in a volfs path to a regular file path, primarily to help you interpret APFS errors.
It requires you to drag and drop a file from the same APFS volume onto its view. It then displays the volfs path for
that file in the File text box.

To resolve the regular file path, paste its Inode number in the text box above, then click on the Resolve button. A
few seconds later it then displays the file path and other information in the scrolling text view below, using the
command GetFileInfo. If you don’t enter an inode number, it resolves the path for the file that you dropped
onto its view. Attributes shown are explained in man GetFileInfo.
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Data... menu: Double

O O Mints Double Arithmetic Tests

Double arithmetic tests:

Muller-Kahan test results:
3 18.5

4 9.378378378378379
5 7.801152737752169
6 7.154414480975333
7 6.806784736924811
8 6.592632768721792
9 6.449465934053933
10 6.348452060746624
11 6.274438662728116
12 6.218696768582163
13 6.17585385581539
14 6.142627170481006
15 6.120248704570159
16 6.166086559598099
17 7 223RA211ARR24021

This suite of tests looks at floating point arithmetic using the standard Swift type Double. These include the results
of ‘difficult’ tests which normally generate inaccurate results, including the Muller-Kahan test, the Chaotic Bank,
and the Rump test. For each, the standard result generated by modern Intel processors is given. The final group
of tests demonstrates how calculating in different orders can induce numeric errors.

- Floating Point Explorer
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Data... menu: Normalizer

O Mints Normalizer
Text Café Angstrom
C (precomp) D (decomp)

Form C Café Angstrom
436166 c3a920c3856e677374726f6d
Form D Café Angstrom

43 6166 65 cc 8120 41 cc 8a 6e 67 73 74 72 6f 6d

The Mints Normalizer window helps you address problems with normalization forms in Unicode text, most
particularly in file paths and names. Paste (or type) the text into the top text box and press Tab or Return. Mints
then shows whether the text complies with Unicode Normalized Form C (‘precomposed’) and/or D (‘decomposed’).
Following that, it gives the Form C normalized form of that text, both in characters and in UTF-8, and the same for
the Form D normalized form.

To use this to normalize Unicode text, for example, to Form D for use with a Mac file system, paste the text into
the top box, and copy the text shown in the Form D box below.

More extensive information about normalization is available in my free app Apfelstrudel.
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o [} Floating Point Explorer

3.141592653589793 x 10 .
v A

+8 1.5707963267948966 x 2 .

ulp 4.440892098500626e-16

o infinite
binade 2.0
zero

hex |400921FB54442D18 > normal

subnormal
Double (64-bit) @ canonical

NaN

=» Contents

This window helps you work with IEEE 754 32- and 64-bit floating-point numbers. Enter any number in one of

three formats:

Radix 10, expressed as significand x 107index, such as 1.234 x 1072 representing 123.4, in the upper row,
then click on the down button or press the down cursor key to see it below using a radix of 2 as represented

internally, and in hexadecimal at the foot.

« Radix 2, expressed as significand x 2*index, such as 1.5 x 272 representing 6.0, in the middle row, then
click on the up button or press the up cursor key to convert it to radix 10 in the row above, and in

hexadecimal at the foot.

Hexadecimal, packed in 4 or 8 bytes according to standard single and double formats, then click the = right
button on the right of the hex box or press the right cursor key to convert it to both radix 10 and 2 formats

above.

- Floating Point Explorer (concluded)

The Eclectic Light Company blog — https://eclecticlight.co



https://eclecticlight.co

=» Start =» Contents
Floating Point Explorer (concluded)

To help you convert hex formats, you can include white space to make them easier to enter and read, e.g. 4009
21FB 5444 2D18. That will be stripped when the hex is converted. Hex values are also automatically padded with
zeros at the left, to the expected number of bytes according to the length of its hex representation.

In addition to showing those three formats of numbers, the window also displays the ulp, binade, and checkboxes
identify special representations, such as NaN (not a number), infinities, zeros, and whether the number is normal

or subnormal. Terms used comply with IEEE 754:
+ ulp is the unit of the least significant digit in this value’s significand; for most, this is the difference between

that number and the next greater representable number.
- binade is the number with the same index, but with a unit significand.

Switch number format between 32-bit single-precision and 64-bit double using the popup menu at the foot of the
window, following which conversions will be made into the format you set.
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Updates

Whenever you open Mints, it may check to see if an update is available. This doesn’t use the popular Sparkle mechanism
for updating in place, but works as detailed here.

Once Mints has successfully completed its integrity check, it checks whether update checking has been turned off in its
preferences file. If that has, it abandons any attempt to check for updates. If checking is allowed, it then checks when it last
checked for updates. If that was more than 12 hours ago, it continues to perform the check. It then connects to my GitHub
server, from where it downloads a list of current versions of my apps. It doesn’t upload any data to the GitHub server at all,
and no statistics beyond GitHub normal connection figures are collected either: no personal identifiers are recorded.

If there is an update available, Mints then checks that its location is on this WordPress blog, and posts a dialog which
invites you to download the update.

If you click on the Download button, it then points your default browser at that update, which should trigger the update to
be downloaded to your normal downloads folder. The update is received as a regular Zip archive, and is exactly the same
as you would download from the Downloads page here. It also carries a quarantine flag, so that when you unZip it and
install the app inside, it undergoes normal first run ‘Gatekeeper’ security checks. If you click on the Ignore button, Mints
won’t remind you about it again for another 12 hours.

An additional item at the end of the Help menu explains the update status. If no update check is performed, or the check
fails, the last item reads Update not checked. If the check is performed and update information is obtained, even when no
update is available or you decline to download it, that menu item reads Checked for update and is ticked (but still
disabled).

You can customise this behaviour by changing Mint’s preferences. The keys to use are:
noUpdateCheck, a Boolean. When set to true, this disables all update checking. Default is false.
updateCheckInt, a real number (Double). When set to a value greater than 1.0, the minimum time interval between checks, in
seconds. Default is 43200, which is 12 hours. If you set it to any value less than 1, Ulbow will reset it automatically to that
default.

To change either of these, use a Terminal command of the form
defaults write co.eclecticlight.Mints updateCheckInt '10'

which works properly through the preferences server cfprefsd.
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Further Information

The monospace font using in versions of macOS up to and including Mojave is monospacedDigitSystemFont;
that used in Catalina and Big Sur is monospacedSystemFont, which is unfortunately not available in earlier
versions of macOS. Both are used in their regular weight.

Predicates used to obtain log extracts include:
* subsystem == "com.apple.clouddocs" OR subsystem == "com.apple.cloudkit" OR subsystem ==
"com.apple.mmcs" OR processImagePath CONTAINS[c] "cloudd" OR processImagePath CONTAINS[c]

"bird" OR processID = 0 (for iCloud)

* subsystem == "com.apple.TCC" OR subsystem == "com.apple.launchservices" OR subsystem ==
"com.apple.securityd" OR subsystem == "com.apple.sandbox" OR processImagePath CONTAINS[c]
"tccd" OR processImagePath CONTAINS[c] "sandboxd" OR processID = 0 UOFT(X:)

* subsystem == "com.apple.TimeMachine" OR (subsystem == "com.apple.duetactivityscheduler" AND
eventMessage CONTAINS[c] "Rescoring all") OR (subsystem == "com.apple.xpc.activity" AND

eventMessage CONTAINS[c] "com.apple.backupd-auto") OR eventMessage CONTAINS[c] "backup" OR
eventMessage CONTAINS[c] "Time Machine" OR eventMessage CONTAINS[c] "TimeMachine" UorThne

Machine)

* subsystem == "com.apple.duetactivityscheduler" OR subsystem CONTAINS "com.apple.xpc" OR
processID = 0 (for DAS scheduling)

* subsystem == "com.apple.spotlightserver" OR subsystem CONTAINS "com.apple.spotlightindex" OR

subsystem CONTAINS "com.apple.DiskArbitration.diskarbitrationd" OR processImagePath
CONTAINS[c] "mdworker shared" OR processImagePath CONTAINS[c] "mds_stores" (for Spotlight)

* subsystem == "com.apple.AppStore" OR subsystem == "com.apple.AppleMediaServices" OR subsystem
== "com.apple.appstored" OR subsystem == "com.apple.JetEngine" OR processID = 0 (for the App
Store)
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* subsystem CONTAINS[c] "com.apple.diskmanagement" OR subsystem CONTAINS|[c]
"com.apple.mobileaccessoryupdater" OR subsystem CONTAINS[c]
"com.apple.DiskArbitration.diskarbitrationd”" OR senderImagePath CONTAINS[c]

"IOAccessoryManager" OR senderImagePath CONTAINS[c] "apfs" (for Disk Mount)
* subsystem == "com.apple.VisionKit" OR subsystem == "com.apple.espresso" OR subsystem ==

"com.apple.siri.argos" OR subsystem == "com.apple.mediaanalysis" OR subsystem ==
"com.apple.CoreRecognition" OR subsystem == "com.apple.trial" OR subsystem ==

"com.apple.pegasuskit" OR subsystem == "com.apple.coreml" OR processImagePath CONTAINS[c]

"mediaanalysisd" (for Look Up)
e subsystem == "com.apple.trial" OR subsystem == "com.apple.triald" OR subsystem ==
"com.apple.cloudkit" OR processImagePath CONTAINS[c] "triald" OR processImagePath CONTAINS[c]

"mediaanalysisd" (for Trial)

¢ subsystem == "com.apple.SoftwareUpdateMacController" AND eventMessage CONTAINS[c]
"Initialized new device:" (for Software Update)
e subsystem == "com.apple.XProtectFramework.PluginAPI" AND category == "XPEvent.structured" (for

XProtect scans).

The log show command used for Trial and Look Up includes the return of Signposts, and log contents have the
category field prefixed, as extensive use is made of categories in log entries for these sub-systems.

Extensive information about Mints and the unified log is available from the Eclectic Light Company blog, and the
product page in particular. That can be accessed through the Mints Support command in the Help menu too.
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Change list
1.18:
+ added hex support to the Floating Point Explorer.
1.17:
+ fixes a bug in the information about sudo vulnerabilities
+ added Floating Point Explorer.
1.16:
+ added sysctl Information.
1.15:
+ added inode resolution to the Data menu.
1.14:
+ fixes a crashing bug in Disk Check if an unmounted volume is selected
+ updates xattr handling to remove deprecations.
1.13:
+ fixes a crashing bug in Disk Check if a network or non-local volume is selected.
1.12:
+ added Disk Check feature.
1.11:
+ added Disk Mount log access.
1.10:
+ added Unified log information
* removed app integrity checking.
1.9:
+ added XProtect Remediator scan feature.
1.8:
+ added Software Update feature.
1.7:
+ added Trial log access.
1.6:
+ added Look Up log access
+ added Visual Look Up browser window
+ built for 12.3 and earlier using Xcode 13.3.
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1.5:
+ added Boot feature to discover boot times
+ added Unicode Normalizer to Data menu
+  improved Spotlight search test window handling
+ added QoS where relevant.
1.4:
+ added App Store log access

+ added Window/Data... menu with a single window for Doubles.
1.3:
. improved opening log checks to detect time formatting errors.
. refactored the display of log entries to reduce memory requirements and increase performance.
. brought all time formatting into line with latest changes in macOS 11.
1.2:
. added opening log checks to protect against macOS bugs.
1.1:
. added busy spinner and search timing to Spotlight test

. added sudo test to the Environment feature.

1.0:

. additional files for Spotlight test

. added mdimporter info for Spotlight test

. first full release.
1.0b11

. added Environment info window

. added Spotlight section, complete with test files

. laid out main window more systematically.
1.0b10:

. added many new items to the Mac Info feature, with support for Apple Silicon Macs too.
1.0b9:

. added DAS Scheduling log browser

. revised Volume Info and corrected its coverage and information

. fixed a bug in Mac Info which resulted in crashing if that Mac’s logic board had no serial number.
1.0b8:

. added Mac Info feature
1.0b7:

. added Volume Info feature

. added Keychain Info feature
. added support for saving via menu command to main windows.

. added Mach Absolute Time feature
. minor tweaks to the interface.

1.0b5:
. changed algorithm used by Universal Binary Checker to stop using lipo
. Universal App for for Intel and Apple Silicon Macs.

1.0b4:
. changed standard log text colours to black/white, red, blue, green
. added Universal Binary Checker for 10.14 and above.

1.0b3:
. tried to fix further bug opening log windows in Sierra.

1.0b2:
. fixed weird bugs in the log window nib.

1.0b1:

. first beta release, with iCloud, TCC and Time Machine log browsers.

18 February 2024.
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